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Introduction to the 
CS490000 Humidity 
Sensor 

he CS490000 is a single chip relative humidity and temperature multi sensor 
module comprising a calibrated digital output. Application of industrial CMOS 
processes with patented micro-machining (CMOSens® technology) ensures 
the highest reliability and excellent long term stability. The sensor head is 

connected to the pins by a small bridge to minimize heat conduction and response 
time. A 2-wire serial interface and internal voltage regulation allows easy and fast 
system integration with a C Stamp. The Sensor is compatible with the C Stamp 
microcomputer’s supplies and signal levels. 

Registering Your C Stamp or C Stamp Related 
Product 
At A-WIT Technologies we respect your privacy; however, we do ask you to register 
your C Stamp or C Stamp related product, so you can receive free of charge product 
updates. The registration procedure is simple. Just send an e-mail to tech_support@a-
wit.com with the word “REGISTRATION x” in the subject line, where “x” is the 
product number that you purchased. If you purchased more than one product, send an 
e-mail for each different product. 

Introduction to the CS490000 Humidity Sensor 
The CS490000 is a single chip relative humidity and temperature multi sensor module 
comprising a calibrated digital output. Application of industrial CMOS processes with 
patented micro-machining (CMOSens® technology) ensures the highest reliability and 
excellent long term stability. The sensor head is connected to the pins by a small bridge 
to minimize heat conduction and response time. All pins are gold plated to avoid 
corrosion even under the harshest operating conditions. The device includes a 
capacitive polymer sensing element for relative humidity and a band-gap temperature 
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sensor. Both are seamlessly coupled to a 14-bit analog to digital converter and a serial 
interface circuit on the same chip. This results in superior signal quality, a fast response 
time and insensitivity to external disturbances (EMC) at a very competitive price. Each 
CS490000 is individually calibrated in a precision humidity chamber. The calibration 
coefficients are programmed into the sensor's non-volatile memory. These coefficients 
are used internally during measurements to calibrate the signals from the sensors. The 
2-wire serial interface and internal voltage regulation allows easy and fast system 
integration with a C Stamp. Its tiny size and low power consumption makes it the 
ultimate choice for even the most demanding applications. The Sensor is compatible 
with the C Stamp microcomputer’s supplies and signal levels. Communicating with the 
Sensor is made easy with A-WIT's supplied software command HUMSIN. This simple 
one command interface is all that is required to setup and acquire Relative Humidity, 
Temperature, and Dew Point readings from the Sensor. 

Technical Specifications 
High precision relative humidity and temperature sensors 

Measurement range: 0-100% RH 

Humidity Accuracy: ±3.0% RH 

Repeatability RH: ±0.1% RH 

Temperature Accuracy: ±0.4 °C 

Dew point 

Fully calibrated, digital output 

Excellent long-term stability 

No external components required 

Fast response time < 4 seconds 

Ultra low power consumption (typ. 30 µW) 

Small size 

Automatic power down 

Applications include Weather Stations, humidifiers, dehumidifiers, Test & 
Measurement, Data logging, and automation 

4-pin SIP package 
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Compact and breadboard-friendly 

Compatible with C Stamp microcomputer 

Detailed Pin Description 
The figure below shows the pins arrangement of the CS490000, and the following 
table shown the Detailed Pin Description. 
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The pin out figure is with the actual sensor chip (black) facing you. 

Humidity Sensor Pin-Out Connectivity 

Pin Symbol Description 

1 SCK Serial clock input. 

Connect to any C Stamp I/O pin. 

2 VDD Supply 2.4 – 5.5 V. 

3 GND Ground pin. 

4 DATA Serial bidirectional data. 

Connect to any C Stamp pin from the following list: 28, 29, 31 
– 38. 
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Getting Started 
his chapter is a quick start guide to using the CS490000 Humidity Sensor with 
the C Stamp. This assumes you have a C Stamp and an appropriate 
connection kit or development board with the RESET and START circuitry, 
and the Humidity Sensor properly connected to the C Stamp. You will also 

need a programming cable, power supply, PC running Windows® 2000/XP/Media, 
with a quantity of RAM recommended for the OS, sufficient free hard disk drive space 
for the software installations, CD-ROM drive, Internet access (recommended only), 
and available port compatible with your programming cable. 

Notices 
CSTAMP™ and CSTAMP™ Related Hardware Products, Software 
Products and Documentation are developed and distributed by A-WIT 
Technologies, Inc. All rights reserved by A-WIT Technologies, Inc. A-WIT 
SOFTWARE OR FIRMWARE AND LITERATURE IS PROVIDED 
“AS IS,” WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL A-WIT BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY ARISING OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR FIRMWARE OR THE USE OF 
OTHER DEALINGS IN THE SOFTWARE OR FIRMWARE. 

MPLAB C-18 and MPLAB C-18 Users Guide is reproduced and 
distributed by A-WIT Technologies, Inc. under license from Microchip 
Technology Inc. All rights reserved by Microchip Technology Inc. 
MICROCHIP SOFTWARE OR FIRMWARE AND LITERATURE IS 
PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL MICROCHIP BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY ARISING OUT OF OR IN 
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CONNECTION WITH THE SOFTWARE OR FIRMWARE OR THE 
USE OF OTHER DEALINGS IN THE SOFTWARE OR 
FIRMWARE. 

Getting Support 
If possible, please check the C Stamp website www.c-stamp.com under SUPPORT for 
any updates to documentation, changes, or notices that may have become available 
since your Installation CD was produced. If you continue to have any issues for which 
a solution is not found in the aforementioned website, please e-mail tech_support@a-
wit.com for help. 

Installing the Microchip MPLAB and C Compiler 
Software 
The first step is to install the Microchip MPLAB software that you will use to develop 
your programs. 

Insert your A-WIT provided Installation CD in your CD drive. Go to the MPLAB 
directory in the CD and double click on the “MPLAB vX.XX Install” file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

After the MPLAB installation is complete, switch to the C18 directory in the CD, and 
double click on the file in that directory. Follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. The only 
exceptions to accepting all the default options is that on the 5th and 6th windows of the 
installation process for the C18 Compiler, you have to select everything as shown in 
the figures below. This will ensure that MPLAB is configured to use the C18 Compiler. 
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Installing the A-WIT C Stamp Quick Programmer 
To install the A-WIT C Stamp Quick Programmer, switch to the CSTAMPQP 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Installing the USB Software 
If you purchased a product with a USB download cable, make sure that the A-WIT 
provided CD is in the CD drive of your PC and insert the USB cable in the USB port 
of your PC. Windows auto detects the new USB device. If Windows prompts you to 
install drivers for the USB cable device, follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. 

After the USB adapter has been installed, open a Windows Explorer window from the 
Accessories sub-menu in the Start menu, and right click on My Computer. Proceed to 
select Properties, and then select the Hardware tab. Click on the Device Manger 
button, and expand the Ports (COM & LPT) branch. Make a note of the COM port 
that has been assigned to the USB-to-Serial adapter. This is the port that should be 
selected in the C Stamp programmer software. 

Setting Up the C Stamp Software Templates 
To set up the C Stamp Software Templates, switch to the CSTAMP_Template 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Documentation 
Copy the DOCS directory from the C Stamp Installation CD to your C:\A-WIT 
directory. This directory contains all the C Stamp related documentation in PDF 
format. 
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Creating your Humidity Sensor C Stamp Program 
Create a directory where you want to have all the files for your program; for example 
HUMS_APP. We recommend making this directory under your C:\A-WIT directory, 
so you can have all your CSTAMP related files in one place. 

Copy the all files in your C Stamp Software Templates directory C:\A-
WIT\CSTAMP_Template to the directory you just made. 

Open the Microchip MPLAB IDE application. As shown the following figure, the 
IDE has several sub-windows. Depending on the resolution of your screen, your sub-
windows may have a different layout. However; you can move and resize these into the 
position that you want to fit your screen, and your layout for that particular project will 
get saved upon answering yes to the prompt of saving the workspace when you exit 
the software development environment. 

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

 

 

Go to the “File” menu to “Open Workspace…”. Then navigate to your program 
directory, and open CSTAMP_Template.mcw. 

Right click on CSTAMP_Template.mcp in the “Project” sub-window, and “Save 
as…” the name of your program project after you have navigated to your program 
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directory. For example, your program project could be named “HUMS_APP”. Now 
when you open the Microchip MPLAB IDE (Integrated Development Environment), 
and go to your program directory to open the workspace for your program, you will 
see a .mws file with the name of your program preceding it. This is the file that you 
should open any time you want to work on your program. 

Double click on the main.c source and type the following code fragment where it is 
indicated. You can omit the comments for brevity, as they are written here to offer 
clarifications of what the code does. Do pay attention; however, to the indentation of 
the code blocks between curly brackets for loops, if statements, etc. Although 
indenting the code is not a requirement for the compiler to parse your code (i.e. any 
blank spaces are ignored by the compiler), it does help tremendously to make your 
code much more readable, and consequently, it makes finding any errors easier. 
Keywords and function names in the code fragment below are bolded. 

After you START the C Stamp in user mode as explained in the “Downloading and 
Running Your Program” section (this will not be the RESET/BOOT/DOWNLOAD 
mode), the program will run. This program assumes that your Humidity Sensor is 
connected to the C Stamp with the clock pin connected to pin 1 and the data pin 
connected to pin 28. You will also need an LED connected to the C Stamp at pin 46 
with a 287 Ω resistor and another connected to pin 45 as shown in the figure below. If 
you are using the CS310X00 BOL, then the LED connections are available in the 
board already. 
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The program will light LED1 if the Relative Humidity (RH) is below 50.5%, and it will 
light LED2 if the RH is equal or above 50.5%. The program executes indefinitely until 
you restart it by pushing and releasing the RESET button while holding the START 
button and then letting go of the latter. 

  while(1){ 
// Get temperature and set LEDs appropriately 
    if(HUMSIN_CS490000(28, 1, HUMS_REH, ZERO, ZERO) < 
       50.5){  
      STPIND(46, HIGH); 
      STPIND(45, LOW); 
    } 
    else{ 
      STPIND(46, LOW); 
      STPIND(45, HIGH); 
    } 
  } 

Save your program from the “File” menu or by clicking on the appropriate icon in the 
tool bar. Then “Build All” from the “Project” menu or from the tool bar. 

If the code was typed correctly, you will have a file in your program directory with the 
name of your program project and a .HEX extension. An example is 
HUMS_APP.HEX. This is the file that you will download to the C Stamp, as 
explained up ahead. 

If you get an error message or an indication that your program did not build 
successfully in the “Output” sub-window of the IDE, you probably have one or more 
syntax error(s). Double click on the line of the “Output” sub-window that mentions 
the error, and the program line that most likely contains the error will be indicated in 
the sub-window where you were editing your program. Correct as necessary, and 
“Build All” again until you get a successful .HEX file output. 
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Downloading and Running Your Program 
Power up your KIT, and connect the KIT to the PC with the provided cable. Upon 
power up, the C Stamp will be in RESET/BOOT/DOWNLOAD mode. To go back 
to this mode at any time, just push and let go of the RESET button. Then open the A-
WIT C Stamp Quick Programmer application shown in the next figure. 

 

 

The first step is to choose the serial port that you are using from the drop-down menu. 
Then click on “Refresh”, so that the program registers your selection. Your selection 
should show in the status area of the program next to “PORT:”. Then click on “Open 
HEX File” and load/select the HEX file that you had previously created during the 
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development of your program. The status are should indicate that the file has been 
loaded successfully. This is what will be downloaded to the C Stamp. Then click on 
“Connect”, and the PC will be connected to the KIT, and the status area should 
indicate so. To download the HEX file to the C Stamp, just click on “Write Device”, 
and you should see the progress bar after a few seconds, as the HEX file is 
downloaded. At this point, you can click on “Disconnect” to disconnect the PC from 
the KIT, disconnect the serial cable from both the PC and the KIT, and start your 
program manually at the KIT. To do this just push and let go of the RESET button 
while pushing the START button. Then you can let go of the START button. 
Alternatively, you can click on “Normal Mode” to start your program from the PC. 
This will also disconnect the program/PC from the KIT. Then you can disconnect the 
serial cable from the PC and the KIT. You can also instruct the CSTAMP™ Quick 
Programmer to wait several seconds before starting your program from the PC and 
disconnecting by adjusting the “SECONDS TO START” slide. This feature is useful 
in case you want to keep the PC connected with the serial cable, but need time to 
manually set up something in a circuit that you have built. If this is not the case it can 
just be left at the default of “0”, and your program will started from the PC right away. 
After you click “Normal Mode” and your program is started, the CSTAMP™ Quick 
Programmer will not be communicating with the C Stamp any longer, so if you want 
to reconnect, you must click on “Connect” again. 
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Accessory Specific 
Functions and Commands 
Reference 

his chapter describes the functions and commands that are specific to the 
software support of different types of accessories that are available from A-
WIT Technologies to complement the function and projects developed with 
the C Stamp. The user should consult the manual for a specific accessory for 

full information on connectivity and usage. 

HUMSIN_CS490000 
float HUMSIN_CS490000(BYTE Dpin, BYTE Cpin, 

  NIBBLE command, NIBBLE format, 
  WORD timeout); 

The HUMSIN function returns a measurement of Relative Humidity, Temperature, or 
Dew Point. If the function is not successful, it returns the value of 500, which is 
outside the range of any measurement by the sensor in any of the available formats. 
This could mean that there was an error in the arguments of the function or some 
other problem. 

Dpin is a variable/constant/expression that specifies the I/O pin to be used as the 
DATA pin. 

Cpin is a variable/constant/expression that specifies the I/O pin to be used as the 
SCK pin. This pin will be set to output mode. 

command is a variable/constant/expression (1 –  3) indicating the measurement to 
get from the sensor. 

Chapter 

3 

T 



A - W I T  T E C H N O L O G I E S  I N C .  

 15 

Command 
Symbol 

Value Description 

HUMS_REH 1 Returns the Relative Humidity. 

Range: 0% – 100% 

HUMS_TMP 2 Returns the Temperature in the scale given by format. 

Range: -40 – 123.8 °C, or 

Range: -40 – 254.9 °F, or 

Range: 233.15 – 396.95 °K 

HUMS_DPT 3 Returns the Dew Point Temperature in the scale given 
by format. 

Range: -40 – 123.8 °C, or 

Range: -40 – 254.9 °F, or 

Range: 233.15 – 396.95 °K 

 

format is a variable/constant/expression that indicates the format for the returned 
Temperature or Dew Point value according to the table below. This argument is not 
used if the measurement requested is Relative Humidity. In this case, any value can be 
passed to the function (e.g. ZERO), and it will be ignored. However; something always 
must be passed in all the arguments. 

Symbol Value Temperature Scale 

TEMPS_C 1 Degrees Celsius 

TEMPS_F 2 Degrees Fahrenheit 

TEMPS_K 3 Degrees Kelvin 

 

timeout is a variable/constant/expression (0 – 65535) that tells HUMSIN how long 
to wait in mS for valid incoming data. The value of 0 is special; it indicates that the 
function will wait until it receives valid data before it returns. 



A - W I T  T E C H N O L O G I E S  I N C .  

 16 

 



A - W I T  T E C H N O L O G I E S  I N C .  

 17 

Terms & Conditions 
Quality Assurance 

A-WIT has stringent quality control procedures in place to insure the best quality 
products. 

90-Day Limited Warranty 

A-WIT Technologies, Inc warrants its products against defects in materials and 
workmanship for a period of 90 days. If you discover a defect, A-WIT Technologies, 
Inc. will, at its option, repair, replace, or refund the purchase price. After 90 days, 
products can still be sent in for repair or replacement, but there will be a $10.00USD 
minimum inspection/labor/repair fee (not including return shipping and handling 
charges). 

14-Day Money-Back Guarantee 

If, within 14 days of having received your product, you find that it does not suit your 
needs, you may return it for a refund. A-WIT will refund the purchase price of the 
product in the form of a check, excluding shipping/handling costs, once the product is 
received. This refund does not apply if the product has been altered or damaged. If you 
decide to return the products after the 14-day evaluation period, a 20% restocking fee 
will be charged against a credit. 

Disclaimer 

Warranty does not apply if the product has been altered, modified, or damaged. A-
WIT makes no other warranty of any kind, expressed or implied, including any 
warranty of merchantability, fitness of the product for any particular purpose even if 
that purpose is known to A-WIT, or any warranty relating to patents, trademarks, 
copyrights or other intellectual property. A-WIT shall not be liable for any injury, loss, 
damage, or loss of profits resulting from the handling or use of the product shipped.  

How to Return a Product 

When returning, you must first e-mail sales@a-wit.com for a Return Merchandise 
Authorization number. No packages will be accepted without the RMA number clearly 
marked on the outside of the package. After inspecting and testing, we will return your 
product, or its replacement using the same shipping method used to ship the product 
to A-WIT within 30 days. In your package, please include a daytime telephone number 
and a brief explanation of the problem. 

Please contact our Sales Department at sales@a-wit.com if you have any questions 
regarding our warranty policy or if you are requesting an RMA number. 
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